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REACH Partnership Resource Submission Packet 

Introduction 
Thank you for your interest in the Centers for Disease Control and Prevention’s (CDC) OneLab 
REACH learning management system. This resource guide contains forms and checklists you 
will need to prepare and submit with your materials for inclusion within the REACH system.
Resources should be submitted to OneLab REACH using the request form here. Disclaimer: We
may make edits to resources that have been submitted to ensure they are 508 compliant. 

Please note that all training materials and media files you submit must be 508 compliant to be 
hosted on REACH. For more information, check out the Accessibility Conformance Checklists | 
HHS.gov.

We’ve included some definitions below to help you navigate the checklists: 

What is alternate text (alt text)?
Screen reading software is used by people who are blind or who have low vision. Screen 
readers can only speak text that is in the document or web page. For any non-text content, text 
must be added so that it can be accessible to people with limited or no vision. Alternative text 
is read by screen readers in place of images, allowing the content and function of the image to 
be accessible to people with limited or no vision. 

What is an informative image?
Images may be meaningful (informative) or decorative. An informative image – such as a chart, 

graph, or illustration – conveys a message or action. A decorative image simply complements 

the text on a page, and should be semantically marked as decorative, or saved as an artifact. 

What is a long description?
When a graphic cannot be explained concisely with alternative text (“alt text”), it needs a long 
description. For example, a chart with robust data must have a long description that details the 
relationship between data points for users who cannot see the image. It can be placed below 
the image on the page. 

What is your focus area? 
REACH training materials fall into nine focus areas. Each area has been defined below. You will 
be asked to select a primary and secondary focus area for your materials. The primary focus 
area is where your resource will be hosted. Secondary categories will be used as filters or tags 
for sorting by various subjects.  

https://www.hhs.gov/web/section-508/accessibility-checklists/index.html
https://www.hhs.gov/web/section-508/accessibility-checklists/index.html
https://www.wrike.com/frontend/requestforms/index.html?token=eyJhY2NvdW50SWQiOjM2NjQ5NjUsInRhc2tGb3JtSWQiOjEyOTYxMDd9CTQ4NTk4MDU5NzY3NjIJZTc0M2IyZTk4NTE4MTc2MDM5NWEzYzRiOGIxNTAyODRiMDliNWE3YTE0MmNkNjgzMWZiYzk0NTFkMzRkN2Q4ZQ==
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Focus Areas

Quality 

To improve the quality and safety of laboratory testing in clinical and public health settings. 

Safety  

To address the knowledge, skills, and abilities necessary to ensure a safe working environment that 

meets or exceeds applicable regulatory requirements and guidelines.  

Core Science  

To improve skills, methods, and procedures in clinical and public health laboratories through job aids 

and courses.  

Laboratory Fundamentals  

To provide a set of foundational knowledge and capabilities needed for testing samples across the wide 

spectrum of scientific and technical activities of public health laboratories.  

Informatics  

To improve the exchange and use of laboratory testing data. It addresses the knowledge, skills, and 

abilities needed to systematically apply information science, computer science, and information 

technology to support public health practice, research, and learning.  

Preparedness and Response  

To enhance the preparedness and response capabilities of the clinical and public health testing 

community.  

Diagnostic Testing  

To improve clinical and public health diagnostic testing. 

Packing and Shipping  

To inform and educate laboratory professionals who pack and ship Division 6.2 infectious substances 

and dry ice.  

Workforce Development  

To provide non-technical, including leadership, content to support the continuing education or 

professional development of laboratory professionals and the testing community.  

Web Resources:  

Division of Laboratory Systems (DLS) | CDC 

Lab Training | CDC Training Job Aids 

OneLab REACH | OneLab REACH (cdc.gov) 

https://www.cdc.gov/csels/dls/index.html
https://www.cdc.gov/labtraining/jobaids.html
https://reach.cdc.gov/home
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REACH Partnership Resource Submission Form

This form will be used to submit resources to OneLab REACH and include the details for 
requirements. For technical questions, please contact LabTraining@cdc.gov.     

Submitter Name:  
Submitter Email:  
Partner Organization: 

Media Type: Video Audio PDF Word PPT 

Media Title: 

Media Description (Summarize your media file’s content in 1-2 sentences): 

1. Select the primary focus area of the media. (Check one option.)
Quality  
Safety  
Core Science  
Laboratory Fundamentals  
Informatics  
Preparedness and Response 
Diagnostic Testing  
Packing and Shipping  
Workforce Development  

2. Select all secondary focus areas of the media. (Check all that apply.)
Quality  
Safety  
Core Science  
Laboratory Fundamentals  
Informatics  
Preparedness and Response 
Diagnostic Testing  
Packing and Shipping  
Workforce Development  

3. Next, choose your media type to go directly to the checklist:
Video  Audio Acrobat PDF 
MS PowerPoint MS Word 

mailto:LabTraining@cdc.gov
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Required Video Submission Form

This document outlines the requirements for submitting video files to OneLab REACH. When 
submitting a video file, please follow the guidelines listed below. (For technical questions about 
this form, please get in touch with LabTraining@cdc.gov). 

Please complete the accessibility compliance form below and submit this checklist along with 
your resource. Additionally, please use the “notes” space provided below the checklist to note 
any noncompliant items. 

Notes: 

All documents and any other training materials must be 508 compliant. Please check out the 
Accessibility Conformance Checklists | HHS.gov for additional details. Use the “Web Sites, Web 
Applications & Software” checklist. 

Video 
Requirements 

Details 508 Compliant? 

Frame Rate 25 fps or 29.97 fps 

Video Resolution 1920 x 1080 HD 

Codec H.264

Bit Rate 16 Mbps 

Also Include a 
Low-Res Version 

1280 x 720 HD, H.264, 3 Mbps (target 200 MB; 300 
MB maximum) 

Preferred Format mp4 

Transcripts Ensure that all video files contain transcripts (SRT or 
VTT). 

Captions Ensure that all video files contain captions (SRT or 
VTT). 

Video Types Video submissions should include two separate 
videos – one high-resolution (1920 x 1080) and one 
low-resolution (1280 x 720) version – as well as an 
image for a thumbnail associated with the media 
content. Low-res video files must be less than 300 
MBs (200 MBs is preferred). 

https://reach.cdc.gov/job-aids-resources
mailto:labtraining@cdc.gov
https://www.hhs.gov/web/section-508/accessibility-checklists/index.html
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Required Audio Submission Form 

This document outlines the requirements for submitting audio files to OneLab REACH. When 
submitting an audio file, please follow the guidelines listed below. (For technical questions 
about this form, please get in touch with LabTraining@cdc.gov). 

Please complete the accessibility compliance form below and submit this checklist along with 
your resource. Additionally, please use the “notes” space provided below the checklist to note 
any noncompliant items. 

Notes: 

All documents and any other training materials must be 508 compliant. Please check out the 
Accessibility Conformance Checklists | HHS.gov for additional details. Use the “Web Sites, Web 
Applications & Software” checklist. 

Audio 
Requirements 

Details 508 Compliant? 

Preferred 
Format 

mp3 or mp4 (100 MB maximum) 

Captions Ensure that all audio files contain captions (SRT or 
VTT). 

Transcripts Ensure that all audio files contain transcripts (SRT or 
VTT). 

https://reach.cdc.gov/job-aids-resources
mailto:labtraining@cdc.gov
https://www.hhs.gov/web/section-508/accessibility-checklists/index.html
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Required Acrobat PDF Submission Form 

This document outlines the requirements for submitting Adobe Acrobat PDF files to OneLab 
REACH. When submitting a PDF, please include a copy of the original Microsoft source file (e.g., 
Word, PowerPoint) if available. (For technical questions about this form, please get in touch 
with LabTraining@cdc.gov).  

Please complete the accessibility compliance form below and submit this checklist along with 
your resource. Additionally, please use the “notes” space provided below the checklist to note 
any noncompliant items. 

Accessibility Features 508 Compliant?

Document

Document has title, author, subject, and keywords (embedded in the file 
properties)

Document language is specified

Any text that is in a different language than the primary language of the 
document is semantically specified

Document has been tested with a screen reader

Links

Links have actual text (no images in place of text)

Link text indicates the purpose of each link

The full hyperlink is included for all links

Links are default blue with underline

Images

All images are high quality and free of pixelation issues

Text embedded in images is legible

Text embedded in images is spelled out in alt text or a long description

Decorative images are marked as either “decorative” or artifacts

Meaningful images have appropriate alt text

Meaningful images are marked as figures

Complex images/infographics have a long description

Header and Footer

Information in the header or footer is repeated in the page text

Tags

There is no unmarked or untagged content in the document

https://reach.cdc.gov/job-aids-resources
https://reach.cdc.gov/job-aids-resources
mailto:labtraining@cdc.gov
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Any content that should not be displayed to a screen reader user is 
semantically marked as an artifact or decorative

All real page text is semantically tagged as either <p> or H1-H6

Form fields

Text boxes and other elements are tagged with a tooltip

Alt text gives instructions to screen reader users (e.g., “write your 
feedback here”)

List Items

All lists are tagged as lists in the tag tree

There are no image-based list bullets

There are no sub-lists

General

Document passes Acrobat Accessibility Checker with no errors

All warnings have been manually checked

File name is descriptive & less than 31 characters (including spacing)

Document has no functionality problems

Notes: 

Additional Requirement for PDF Document Submissions 

Please indicate the original source document (e.g., Word, PowerPoint) you are including, if 
available, along with your PDF: 

Word Doc PowerPoint File Other 

All documents and any other training materials must be 508 compliant. Please check out 
the Accessibility Conformance Checklists | HHS.gov for additional details. Use the “Adobe 
PDF” checklist.

https://www.hhs.gov/web/section-508/accessibility-checklists/index.html
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Required Microsoft Word Submission Form

This document outlines the requirements for submitting Word files to OneLab REACH
(For technical questions about this form, please get in touch with LabTraining@cdc.gov). 

Please complete the accessibility compliance form below and submit this checklist along with 
your resource. Additionally, please use the “notes” space provided below the checklist to note 
any noncompliant items. 

Accessibility Features 508 Compliant?

Structural & Semantic Elements

Headings are created using Styles (not just large or bold text)

Headings are accurate and informative

Headings follow hierarchical levels (H1-H6)

Normal page text is tagged as <p> in the Styles pane

Table of Contents is based on headings (when applicable)

Document language is specified (in Review tab)

Key information in headers/footers appears in the body of the 
document

Footnotes are created using the Insert tool (in the References tab)

Abbreviations and acronyms are spelled out or explained

The document does not contain multiple text columns

Superscripts or subscripts are used minimally

Page numbers are created using the Page Break tool (in Insert tab)

Links

Links are created using the Link tool, or by right-clicking on text and 
inserting the link

Links have actual text (no images in place of text)

Link text indicates the purpose of each link

The full hyperlink is included for all links

Links are default blue with underline

Styles and Appearance

Images of small text have text captions

Text and background color contrast have been checked for compliance

Line spacing is set to at least 1.5

Lines are left justified

https://reach.cdc.gov/job-aids-resources
mailto:LabTraining@cdc.gov
https://webaim.org/resources/contrastchecker/
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Text and Fonts

Fonts are easily readable and 12 pts or larger

Symbols used to convey meaning are explained in plain text on the page

Text effects, Word Art, ALL-CAPS, and DROP-CAPS are not used

Body text is standard black (no color except for defined links)

Images, Shapes and SmartArt

All images with conveyable content have meaningful alt text

Alt text for informative images (i.e., pie charts) is 150 characters or less

Complex images include both alt text and a text long description

Text boxes are placed in line with page text and have alt text

Smart Art objects are placed in line with page text

Smart Art objects include alt text (and long description, if necessary)

All shapes that have meaning have alt text

Data Tables

All tabular data are represented in a real (MS Word created) table

Tables have a title, one header row, and/or one header column

Tables do not contain nested tables or merged or split cells

Tables are in line with the text

Layout tables do not have table data header designations

Charts and Graphs

All charts are placed in line with the text

All charts have alt text and a long description if needed

Lists

All lists are created using the MS Word List feature

Lists do not have image-based bullets

General

Document passes Accessibility Checker with no errors and is .docx

File name is descriptive and less than 31 characters (including spacing)

Notes:

All documents and any other training materials must be 508 compliant. Please check out 
the Accessibility Conformance Checklists | HHS.gov. Use the “Microsoft Word” checklist.

https://www.hhs.gov/web/section-508/accessibility-checklists/index.html
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Required MS PowerPoint Submission Form

This document outlines the requirements for submitting PowerPoint files to OneLab REACH. 
(For technical questions about this form, please get in touch with LabTraining@cdc.gov). 

Please complete the accessibility compliance form below and submit this checklist along with 
your resource. Additionally, please use the “notes” space provided below the checklist to note 
any noncompliant items.

Accessibility Features 508 Compliant? 

Structural & Semantic Elements 

Headings are accurate and informative, and follow H1-H6 style levels 

Abbreviations and acronyms are spelled out or explained 

Styles, Appearance & Links 

Text and background color contrast is appropriate 

Line spacing for paragraphs is set to at least 1.5 pts 

Links are actual text, and the purpose of each link is clear 

Text and Fonts 

Normal page text is marked as <p> through the Styles pane 

Slide fonts are easily readable and 16 pts or larger 

No ALL-CAP, DROP-CAP, Text Effects or Word Art treatments are used 

Images, Shapes and SmartArt 

Any series of related images or shapes is grouped 

All images with conveyable content have meaningful alt text 

Decorative images are labeled as such in the alt text box 

All shapes and symbols that have meaning (like an arrow) have alt text 

Graphs and Charts 

Graphs and charts have alt text and a long description (if needed) 

Parts of graphs or charts have a 3 to 1 minimum contrast (i.e., pie slices) 

General 

Reading order has been verified by using the Tab key 

File passes MS PowerPoint Accessibility Check with no errors 

Notes:

All documents and any other training materials must be 508 compliant. Please check out the 
Accessibility Conformance Checklists | HHS.gov. Use the “Microsoft PowerPoint” checklist.

https://reach.cdc.gov/job-aids-resources
mailto:LabTraining@cdc.gov
https://www.hhs.gov/web/section-508/accessibility-checklists/index.html
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For Internal TWDB Use Only 

REACH Video and Audio Checklist 

(The CDC POC will confirm that audio/video submissions include the information below.)

 REACH Partner Video and Audio Media Checklist 508 Compliant?

1.1 Content 

1.1.1 One primary focus area is selected 

1.1.2 Secondary focus areas are selected

1.2 Additional Video or Audio Details

1.2.1 Captions are provided for all video or audio files

1.2.1 Transcripts are provided for all video or audio files

1.2.2 Video files are shared in mp4 format

1.2.3 Video submissions include high-res (1920 x 1080) and 
 low-res (1280 x 720) versions 

1.2.4 Low-res video files are less than 300 MB 

1.2.5 Video files include a thumbnail associated with the media content

1.2.6 Audio files are in mp3 or mp4 format and are not larger than 100 MB

 Reviewer Name: Date of Review:

 Approval Status: Approved Not Approved 

 Notes: 

For POC Reviewer
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REACH PDF Document Checklist 

For Internal TWDB Use Only

(The CDC POC will confirm that PDF submissions include the information below.)

 REACH Partner PDF Document Checklist 508 Compliant?

1.1 Form

1.1.1 An informative text description of the PDF is included

1.1.2 One primary focus area is selected 

1.1.3 Secondary focus areas are selected

1.2 Content

1.2.1 Document properties and language are specified

1.2.2 Links are semantically correct and descriptive

1.2.3 Images are high quality and legible (if contain text)

1.2.4 All images include alt text or a long description

1.2.5 All normal page text is tagged as either <p> or H1-H6

1.2.6 All fonts are legible and font size meets standards

1.2.7 Form fields are marked semantically (if present)

1.2.8 All lists are marked semantically, and do not include image-based bullets

1.2.9 Passes manual color contrast check

1.3 Additional PDF Details

1.3.1 File name is descriptive & less than 31 characters

1.3.2 Has no functionality problems

1.3.3 Has been tested in a screen reader

1.3.4 Content is legible and easy to read 

1.3.5 Images, tables and graphics are clear, readable, and align with content 

1.3.6 Translated documents (English to Spanish, for example) have been vetted

    Reviewer Name: Date of Review:

    Approval Status: Approved Not Approved

    Notes:

For POC Reviewer
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REACH MS Word Checklist 

For Internal TWDB Use Only

(The CDC POC will confirm that MS Word submissions include the information below.)

 REACH Partner MS Word Document Checklist 508 Compliant?

1.1 Form 

1.1.1 One primary focus area is selected 

1.1.2 Secondary focus areas are selected

1.2 Content

1.2.1 Document properties and language are specified

1.2.2 Links are semantically correct and descriptive

1.2.3 Images are high quality and legible (if contain text)

1.2.4 All images include alt text or a long description

1.2.5 All normal page text is tagged as either <p> or H1-H6

1.2.6 All fonts are legible and font size meets standards

1.2.7 Form fields are marked semantically (if present)

1.2.8 All lists are marked semantically, and do not include image-based bullets

1.3 Additional MS Word Details

1.3.1 Word file passes Accessibility Checker with no errors

1.3.2 All images and non-text features include alt text

1.3.3 All links are descriptive and formatted correctly

1.3.4 All tables have a designated header row

 Reviewer Name: Date of Review:

 Approval Status: Approved Not Approved

 Notes:

For POC Reviewer
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REACH PowerPoint File Checklist 

For Internal TWDB Use Only

(The CDC POC will confirm that PowerPoint submissions include the information below.)

 REACH Partner PowerPoint Checklist 508 Compliant?

1.1 Form 

1.1.1 One primary focus area is selected 

1.1.2 Secondary focus areas are selected

1.2 Content

1.2.1 Document properties and language are specified

1.2.2 Links are semantically correct and descriptive

1.2.3 Images are high quality and legible (if contain text)

1.2.4 All images include alt text or a long description

1.2.5 All normal page text is tagged as either <p> or H1-H6

1.2.6 All fonts are legible and font size meets standards

1.2.7 Form fields are marked semantically (if present)

1.2.8 All lists are marked semantically, and do not include image-based bullets

1.3 Additional PowerPoint Details

1.3.1 Compliant alt text is present for all images

1.3.2 Reading order of all slides has been verified

1.3.3 Passes all MS PowerPoint compliance checks

1.3.4 Fonts are not overly decorative 

1.3.5 Use of color in type and charts passes contrast checks 

1.3.6 Videos include an audio track with video descriptions

1.3.7 Videos that include dialogue also include closed captions

 Reviewer Name: Date of Review:

 Approval Status: Approved Not Approved

 Notes:

For POC Reviewer
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